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 Using this Document 

 
Before You Begin 

 
This document details how to upgrade an existing MassTransit installation to MassTransit 5.1.  Please 
follow the steps carefully to ensure that all of your settings are maintained with the new installation.  
 
Before starting the upgrade process, please verify that you have the following: 

• Version number of MassTransit you are currently running. 

• MassTransit CD for the latest release, or installers downloaded electronically (see 
http://www.grouplogic.com/files/glidownload/mtreleases.cfm ). 

• The Installation Guide for Macintosh or Windows; this should be included on the CD. 
 
MassTransit Enterprise and Professional users will also need:  

• MassTransit serial number for version 5.  To locate your current version 5 serial number, launch 
the MassTransit Administrator, go to the File menu, and select Server Information.  Your serial 
number is the last item listed in the Licensed To: section.  Users upgrading from 4.5.x must 
obtain a version 5 serial number from Group Logic; see contact information below. 

• MassTransit hardware key also known as a “dongle” -- note that if you are running on Mac OS X 
or Mac OS X Server, a USB dongle is required. 

 
Please contact Group Logic Technical Support if you need to obtain these.  Email 
support@grouplogic.com or call 703-527-7979.  For a complete listing of the latest official release versions 
and documentation, go to http://www.grouplogic.com/files/glidownload/mtreleases.cfm . 
 
 

Upgrading Process 

 
This document includes details on how to install MySQL and MassTransit 5.1.  You should not launch 
MassTransit until you have completed all of the processes outlined in this document.   
 
The upgrading process is a series of major steps: 

1. Backing up your existing installation 
2. Upgrading your databases to the latest version of MassTransit (4.5 upgrades only) 
3. Migrating your configurations to the new MassTransit installation 
4. Verifying the success of the new installation 

 
If you encounter problems during this process, please contact Group Logic Technical Support at 
support@grouplogic.com or 703-527-7979.  It is highly recommended that you back up your original 
MassTransit application folder so that if you encounter problems, you can still run from the backup until 
support can resolve the issue.    
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Making a Backup Before Upgrading 
 
Before upgrading your existing MassTransit installation to a new version it is advisable to make a backup.  
You will need to select a backup location for MassTransit, e.g. a different folder on the same volume, a 
network volume, a CD, etc.  It is highly recommended that you make backups immediately before you 
upgrade and do not run the older version of MassTransit again to ensure that the transition between the 
two servers is seamless.   
 
Perform the following steps to make a backup copy of the MassTransit application folder:   

1. If MassTransit is currently running, quit the application. 
2. Locate the folder that contains the old MassTransit application. 
3. Copy the entire MassTransit application folder to your backup location. 
4. If you are upgrading from 4.5, you may also wish to save your current log to text by 

launching MassTransit, opening the log window, and selecting “Save to text” from the File 
menu.   

 
If you encounter a problem running with the new version of MassTransit, you can revert to this saved 
application folder until the issue can be resolved.     
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Upgrading on Mac OS X  

 

MassTransit Versions Prior to 4.5 
 
Prior to upgrading to MassTransit 5.1, you will need to upgrade your current version of MassTransit to 
MassTransit 4.5.  To download MassTransit 4.5, go to the MassTransit 4.5 Releases section located at: 
http://www.grouplogic.com/files/glidownload/mtreleases.cfm .  This Web site also includes upgrading 
instructions in the MassTransit 4.5 Documentation section.  Once you have successfully upgraded to 
MassTransit 4.5, you can then upgrade to 5.1; follow the instructions below.  If you need assistance 
upgrading, please contact Group Logic Support at support@grouplogic.com or call 703-527-7979. 
 

MassTransit 4.5 to 5.1 
 
To install MassTransit 5.1 on Mac OS X 10.4 client or later, or Mac OS X 10.4 Server or later, you will need 
to have a USB dongle and a version 5 serial number.  ADB dongles are no longer supported.  Please 
contact Group Logic Technical Support if you need to obtain these.  Email support@grouplogic.com or 
call 703-527-7979.   
MassTransit uses a new database format starting in 5.0 and installs to a different installation folder.  You 
should not install to the same directory as your previous MassTransit installation because of this new 
database format.   
 

Enterprise and Professional Servers 
 

1. Log into Mac OS X as the user you will be running MassTransit under.   
2. Be sure that you have sent all queued files.   
3. If MassTransit is currently running, quit the application.   
4. Back up your MassTransit application folder; see the “Making a Backup Before Upgrading” 

section.   
5. Verify MySQL is installed and running; see the Installation Guide for Macintosh included on the 

CD for assistance.  Follow the “Installing MySQL” section.  
6. Install MassTransit 5.1; see the Installation Guide for Macintosh included on the CD for 

assistance.  Follow the “Installing MassTransit” section.  
 

Running the Database (DB) Converter 

 
The DB Converter is a tool installed with MassTransit to convert your databases.  It will convert all 
contacts and their associated data, as well as all configuration settings, including listens, actions, services, 
and priorities.  Files and log tables will not be converted.  The tool consists of two components: “MT 4.5 
DB Export” and “Import 4.5 Data”.  The former exports your 4.5 databases; the latter imports the 
converted databases to 5.1.  If you’re installing MassTransit on a different server, skip to the next section, 
“Running the DB Converter when 4.5 and 5.1 are on Different Servers”. 
 

7. Mount any volumes that MassTransit references because paths to mounted volumes may not be 
imported properly if the path is not valid when the DB Converter runs.  Any volumes that host 
MassTransit User Mailboxes, MassTransit Hot Folders, or MassTransit Drop Folders should be 
mounted.   

8. Double-click MT 4.5 DB Export located in the following default path: /Applications/MassTransit 
Server 5 Folder/DB Converter/45Export. 

a. An introductory window appears; select the Continue button to proceed. 
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b. The “About The Conversion Process” window appears explaining the conversion that is 
about to occur.  Once you have read the explanation, select Continue to proceed. 

c. The “Choose a Folder” window appears asking for the location of your MassTransit 4.5 
application folder.  The default installation path is: /Applications/MassTransit 4.5 
Folder.  Locate the folder and select Choose to continue. 

d. The “Choose a Folder” window appears again asking for the location of your 
MassTransit 5.1 application folder.  The default installation path is: 
/Applications/MassTransit Server 5 Folder.  Locate the folder and select Choose to 
continue. 

e. An “Export Complete” dialog appears when the export is complete.  Select OK to 
continue.  The DB Converter Log.txt populates to the DB Converter folder; this log lists 
everything exported. 

9. Double-click the Import 4.5 Data script located in the following default path: 
/Applications/MassTransit Server 5 Folder/DB Converter/51Import. 

a. The “Choose a Folder” window appears asking for the location of your MassTransit 5.1 
application folder.  The default installation path is: /Applications/MassTransit Server 5 
Folder.  Locate the folder and select Choose to continue. 

b. A series of dialogs appear asking for MySQL information: 
i. Enter the address of your MySQL server: Enter localhost (default).  Select OK to 

continue. 
ii. Enter your MySQL server user name: Use either root (default) or the username 

you created when you installed MassTransit, i.e. “masstransit”.  We recommend 
using your username; it is more restrictive and safer to use.  Select OK to 
continue. 

iii. Enter your MySQL password and select OK to close the dialog. 
c. A dialog appears informing you that the import of MassTransit 4.5 data is complete.  The 

DB Importer Log.txt populates to the DB Converter folder; this log lists everything 
imported. 

10. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 
 

Running the DB Converter when 4.5 and 5.1 are on Different Machines 

 
If you’re installing MassTransit on a different machine, follow these instructions to convert your 
databases.  Note: The DB Converter only converts Mac -> Mac or Win -> Win; the DB Converter does not 
support cross-platform conversions.   
 
When you run MT 4.5 DB Export on your MassTransit 4.5 server, a file called MassTransit Data.xml is 
generated when the conversion completes.  You will have to manually move the MassTransit Data.xml 
file to your MassTransit 5.1 server, run the importer, Import 4.5 Data, and your database conversion will 
be complete. 
 

1. Follow steps 1-7 as listed above. 
2. Put MT 4.5 DB Export anywhere on the MassTransit 4.5 server.  MT 4.5 DB Export is installed by 

MassTransit and is located in the following default path: /Applications/MassTransit Server 5 
Folder/DB Converter/45Export.  It is also included on the CD.   

3. Double-click MT 4.5 DB Export. 
a. An introductory window appears; select the Continue button to proceed. 
b. The “About The Conversion Process” window appears explaining the conversion that is 

about to occur.  Once you have read the explanation, select Continue to proceed. 
c. The “Choose a Folder” window appears asking for the location of your MassTransit 4.5 

application folder.  The default installation path is: /Applications/MassTransit 4.5 
Folder.  Locate the folder and select Choose to continue. 
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d. The “Choose a Folder” window appears again asking for the location of your 
MassTransit 5.1 application folder.  Instead of using the MassTransit 5.1 application 
folder, you can use any folder.  When MT 4.5 DB Export runs, the MassTransit Data.xml 
file is generated and placed in that folder.  This is the file you will manually move to the 
MassTransit 5.1 server.  Locate the folder of your choice and select Choose to continue. 

e. An “Export Complete” dialog appears when the export is complete.  Select OK to 
continue.  The DB Converter Log.txt populates to the DB Converter folder; this log lists 
everything exported. 

4. When the conversion is complete, go to the folder you selected as your MassTransit 5.1 
application folder in step 3d and locate the MassTransit Data.xml file. 

5. Place the MassTransit Data.xml file in the root MassTransit 5.1 folder.  The default path is: 
/Applications/MassTransit Server 5 Folder/. 

6. From the MassTransit 5.1 server, double-click the Import 4.5 Data script located in the following 
default path: /Applications/MassTransit Server 5 Folder/DB Converter/51Import. 

a. The “Choose a Folder” window appears asking for the location of your MassTransit 5.1 
application folder.  The default installation path is: /Applications/MassTransit Server 5 
Folder.  Locate the folder and select Choose to continue. 

b. A series of dialogs appear asking for MySQL information: 
i. Enter the address of your MySQL server: Enter localhost (default).  Select OK to 

continue. 
ii. Enter your MySQL server user name: Use either root (default) or the username 

you created when you installed MassTransit, i.e. “masstransit”.  We recommend 
using your username; it is more restrictive and safer to use.  Select OK to 
continue. 

iii. Enter your MySQL password and select OK to close the dialog. 
c. A dialog appears informing you that the import of MassTransit 4.5 data is complete.  The 

DB Importer Log.txt populates to the 51Import folder; this log lists everything imported. 
7. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 

 

Satellite Servers 
 

1. Log into Mac OS X as the user you will be running MassTransit under.   
2. Be sure that you have sent all queued files.   
3. If MassTransit is currently running, quit the application.   
4. Back up your MassTransit application folder; see the “Making a Backup Before Upgrading” 

section.   
5. Install MassTransit Satellite 5 included on the MassTransit 5.1 CD.  You must use an 

administrative account when installing MassTransit.  
6. Copy your MTClient.CFG file and place it in your MassTransit 5.1 folder. 

 

Running the DB Converter 

 
The DB Converter is a tool installed with MassTransit to convert your databases.  It will convert all 
contacts and their associated data, as well as all configuration settings, including listens, actions, services, 
and priorities.  Files and log tables will not be converted.  The tool consists of two components: “MT 4.5 
DB Export” and “Import 4.5 Data Embedded”.  The former exports your 4.5 databases; the latter imports 
the converted databases to 5.1.  If you’re installing MassTransit on a different server, skip to the next 
section, “Running the DB Converter when 4.5 and 5.1 Satellites are on Different Servers”. 
 

7. Mount any volumes that MassTransit references because paths to mounted volumes may not be 
imported properly if the path is not valid when the DB Converter runs.  Any volumes that host 
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MassTransit User Mailboxes, MassTransit Hot Folders, or MassTransit Drop Folders should be 
mounted.   

8. Double-click MT 4.5 DB Export located in the following default path: /Applications/MassTransit 
Satellite 5 Folder/DB Converter/45Export. 

a. An introductory window appears; select the Continue button to proceed. 
b. The “About The Conversion Process” window appears explaining the conversion that is 

about to occur.  Once you have read the explanation, select Continue to proceed. 
c. The “Choose a Folder” window appears asking for the location of your MassTransit 4.5 

application folder.  The default installation path is: /Applications/MassTransit 4.5 
Folder.  Locate the folder and select Choose to continue. 

d. The “Choose a Folder” window appears again asking for the location of your 
MassTransit 5.1 application folder.  The default installation path is: 
/Applications/MassTransit Satellite 5 Folder.  Locate the folder and select Choose to 
continue. 

e. An “Export Complete” dialog appears when the export is complete.  Select OK to 
continue.  The DB Converter Log.txt populates to the DB Converter folder; this log lists 
everything exported. 

9. Double-click the Import 4.5 Data Embedded script located in the following default path: 
/Applications/MassTransit Satellite 5 Folder/DB Converter/51Import. 

a. The “Choose a Folder” window appears asking for the location of your MassTransit 5.1 
application folder.  The default installation path is: /Applications/MassTransit Satellite 5 
Folder.  Locate the folder and select Choose to continue. 

b. A dialog appears informing you that the import of MassTransit 4.5 data is complete.  The 
DB Importer Log.txt populates to the DB Converter folder; this log lists everything 
imported. 

10. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 
 

Running the DB Converter when 4.5 and 5.1 Satellites are on Different Machines 

 
If you’re installing MassTransit on a different machine, follow these instructions to convert your 
databases.  Note: The DB Converter only converts Mac -> Mac or Win -> Win; the DB Converter does not 
support cross-platform conversions.   
 
When you run MT 4.5 DB Export on your MassTransit 4.5 Satellite server, a file called MassTransit 
Data.xml is generated when the conversion completes.  You will have to manually move the MassTransit 
Data.xml file to your MassTransit 5.1 Satellite server, run the importer, Import 4.5 Data Embedded, and 
your database conversion will be complete. 
 

1. Follow steps 1-7 as listed above. 
2. Put MT 4.5 DB Export anywhere on the MassTransit 4.5 Satellite server.  MT 4.5 DB Export is 

installed by MassTransit and is located in the following default path: /Applications/MassTransit 
Satellite 5 Folder/DB Converter/45Export.  It is also included on the CD.   

3. Double-click MT 4.5 DB Export. 
a. An introductory window appears; select the Continue button to proceed. 
b. The “About The Conversion Process” window appears explaining the conversion that is 

about to occur.  Once you have read the explanation, select Continue to proceed. 
c. The “Choose a Folder” window appears asking for the location of your MassTransit 4.5 

application folder.  The default installation path is: /Applications/MassTransit 4.5 
Folder.  Locate the folder and select Choose to continue. 

d. The “Choose a Folder” window appears again asking for the location of your 
MassTransit 5.1 application folder.  Instead of using the MassTransit 5.1 application 
folder, you can use any folder.  When MT 4.5 DB Export runs, the MassTransit Data.xml 
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file is generated and placed in that folder.  This is the file you will manually move to the 
MassTransit 5.1 Satellite server.  Locate the folder of your choice and select Choose to 
continue. 

e. An “Export Complete” dialog appears when the export is complete.  Select OK to 
continue.  The DB Converter Log.txt populates to the DB Converter folder; this log lists 
everything exported. 

4. When the conversion is complete, go to the folder you selected as your MassTransit 5.1 
application folder in step 3d and locate the MassTransit Data.xml file. 

5. Place the MassTransit Data.xml file in the root MassTransit 5.1 folder.  The default path is: 
/Applications/MassTransit Satellite 5 Folder/. 

6. From the MassTransit 5.1 Satellite server, double-click the Import 4.5 Data Embedded script 
located in the following default path: /Applications/MassTransit Satellite 5 Folder/DB 
Converter/51Import. 

a. The “Choose a Folder” window appears asking for the location of your MassTransit 5.1 
application folder.  The default installation path is: /Applications/MassTransit Satellite 5 
Folder.  Locate the folder and select Choose to continue. 

b. A dialog appears informing you that the import of MassTransit 4.5 data is complete.  The 
DB Importer Log.txt populates to the 51Import folder; this log lists everything imported. 

7. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 
 

Application Clients 
 
The DB Converter does not upgrade Clients. Follow the below instructions to manually upgrade your 
Client.   

1. Log into Mac OS X as the user you will be running MassTransit under.   
2. Be sure that you have sent all queued files.   
3. If MassTransit is currently running, quit the application.   
4. Locate your backup of the MassTransit application folder; see the “Making a Backup Before 

Upgrading” section. 
5. Install MassTransit Client 5 included on the MassTransit 5.1 CD.  You must use an administrative 

account when installing the MassTransit Client.  
6. Copy your MTClient.CFG file and place it in your MassTransit 5.1 folder.   
7. Any customizations you have made outside the MTClient.CFG, like your communication 

methods, will need to be manually reconfigured. 
8. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 

 

Migrating Configurations  
 
The following sections detail how to ensure that all configurations are properly migrated from your old 
MassTransit installation to your new one.  If you installed MassTransit to the default location, the new 
installation folder will be:  /Applications/MassTransit Server 5 Folder 
 

Copying User Mailboxes  

 
Copy your User Mailboxes folder from the backup of your old MassTransit Folder to the new MassTransit 
Folder.  If you choose not to do this, MassTransit will create a new User Mailboxes folder when it starts 
up. 
 
If you are running on Mac OS X and share the user mailboxes, copy the contents of the old “User 
Mailboxes” folder from your previous installation to the “User Mailboxes” folder in the new MassTransit 
folder.  If you want to make the mailboxes available to all users, run the “Set User Mailbox Permissions” 
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script, available on the Group Logic website: 
http://www.grouplogic.com/files/mt/scripts/mac/SetUserMailboxPermissions.hqx 
 
 

Maintaining Verified Certificates 

  
If you are using a verified certificate [e.g. one purchased from VeriSign], you may need to ensure that the 
certificate and private key files are configured properly for the new version of MassTransit.   
 
If the certificate and/or private key files were located in the “Security” folder of your previous 
MassTransit installation you will need to move them to the “Security” folder of the new MassTransit 
installation.  In addition, when you restart MassTransit, go to Setup->Security to update the preferences 
to access the files at their new location.  If you’re using verified SSL certificates, the mtcert.pem (located in 
the Security folder) and mtkey.pem (located in the private folder) files must be manually moved from the 
backed up Security folder into the 5.1 Security folder.   
 
On Windows, if the certificate and/or private key files were not located within the previous MassTransit 
installation folder then no action is needed as MassTransit will continue to find the files in their present 
location if you are installing on the same server.  If you are not installing MassTransit 5.1 on the same 
server, then you will need to copy the certificate and/or private key files to the new server. 
 
On Macintosh, no matter where you install MassTransit 5.1, you will need to convert all SSL certificate 
and key files with Macintosh line endings to Unix line endings.  There is a script called, “Convert 
Certificates to 5.app” that does this in your Extras folder.  The default location is: 
/Applications/MassTransit Server 5 Folder/Extras.   
 

To run the script: 
1. Double-click “Convert Certificates to 5.app”. 
2. A dialog appears with buttons asking you to Convert one file or to Convert a folder 

hierarchy.  If you wish to convert just one certificate or key file, select the Convert one file 
button.  If you wish to convert all of your certificate and key files at once and they are in a 
single folder, select the Convert a folder hierarchy button.   

3. The “Choose a File” or “Choose a Folder” dialog appears based on your selection.  Choose the 
certificate, key file, or folder hierarchy you want to convert.  Select the Choose button to 
continue.  

4. A dialog appears informing you that the script has completed successfully.  It also tells you to 
go to your desktop and locate the folder named, “MassTransit 5 Cert”.  The converted files or 
folder hierarchy are in that folder.  Select OK to close the dialog. 

5. Copy the converted files and place them in the appropriate folder.  If they were in your 
Security folder, put the converted files in the MassTransit 5.1 Security folder, or if they were 
not in your previous MassTransit installation, replace them in that same location.  You can 
overwrite the original files, as they should be saved with your backup. 

 

Preserving MassTransit.cfg Settings For Enterprise and Professional Servers 

 
If you were using the MassTransit.cfg file to specify settings for your previous MassTransit 
installation, you will need to make equivalent changes in the updated version of the MassTransit.cfg 
file.   
 
DO NOT simply drop your old MassTransit.cfg file in the new MassTransit directory.  Some changes 
may have been made to the settings in this file and using the newest version ensures proper operation.   
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1. Copy the new version of the MassTransit.cfg file from the Extras folder of the new 
MassTransit installation to the main MassTransit folder.   

2. Open the new MassTransit.cfg file that you just moved in a text editor. 
3. Open the MassTransit.cfg file that you backed up from your old installation in a text editor.   
4. For each enabled setting in your old MassTransit.cfg file, uncomment the same setting and 

set the value appropriately in the new MassTransit.cfg file.   Settings with a ‘%’ preceding 
them are not enabled.   

5. Save the new MassTransit.cfg file.   
 

 

Maintaining MT IP Addresses.txt 

 
If you were using MT IP Addresses.txt on your previous MassTransit installation, copy the MT IP 
Addresses.txt file that you backed up into the new MassTransit folder.  No changes to the actual file 
are required. 
 

Consider Updating Aliases and Shortcuts 

 
If you have an alias or shortcut that you used to launch the previous version of MassTransit, you may 
want to update it to point to the new version. This is especially important if you have one as a startup 
item, to ensure that the old version of MassTransit is not launched automatically. 
 
 

Web Configuration for Enterprise Servers Only 
 
Starting with MassTransit 5.0 there is a new Web site for web client configuration.  For information about 
configuring MassTransit for use with web servers, see the Web Configuration Instructions document 
located on the MassTransit Latest Releases web page in the MassTransit 5.1 Documentation section:  
http://www.grouplogic.com/files/glidownload/mtreleases.cfm . 
 
 

Other MassTransit 5.1 Resources 
Go to http://www.grouplogic.com/files/mt/51/OtherMassTransit51Resources.html for additional 
articles to help you set up, configure, and use MassTransit 5.1 and its new features.  The Group Logic 
Knowledge Base contains many articles that provide detailed information on MassTransit 5.1 and its 
features and components.  The HTML version of this file, “OtherMassTransit51Resources.html”, is 
provided with your MassTransit 5.1 CD or with your download package. 
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MassTransit 5.0 to 5.1 
 
When upgrading your Enterprise, Professional, Satellite, or Client server to MassTransit 5.1 from 
MassTransit 5.0, it is not necessary to run the DB Converter application.   
 

Enterprise and Professional Servers 
 

1. Log into Mac OS X as the user you will be running MassTransit under.   
2. If MassTransit is currently running, quit the application.   
3. Verify that MySQL is running.   
4. Back up your MassTransit application folder; see the “Making a Backup Before Upgrading” 

section.   
5. Run Install MassTransit Server 5 from the MassTransit 5.1 CD to install MassTransit 5.1.   

• During the installation process, the Enterprise installer gives you the option of backing up the 
MassTransitEngine.cfg file and the entire MTWeb folder.  Select OK to back up your custom 
configuration. 

• During the installation, a dialog appears asking if you would like to share the MassTransit 
User Mailboxes Folder with File Sharing.  You may select Yes or No.  If you select Yes, the 
User Mailboxes folder will be shared via standard Mac OS X file sharing so remote users can 
connect and view the mailboxes. If you select No the installer will NOT change the 
permissions of the existing User Mailboxes folder.  It will be fully accessible locally and you 
can later change the permissions manually.   

6. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 
 

Satellite Servers 
 

1. Log into Mac OS X as the user you will be running MassTransit under.   
2. If MassTransit is currently running, quit the application.   
3. Back up your MassTransit application folder; see the “Making a Backup Before Upgrading” 

section.   
4. Install MassTransit Satellite 5.1 included on the MassTransit 5.1 CD.  You must use an 

administrative account when installing MassTransit.  
5. Copy your MTClient.CFG file and place it in your MassTransit 5.1 folder. 
6. Copy the data folder from your backed up Satellite Databases folder into your 5.1 Databases 

folder.   
7. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 

 

Application Clients 
 

1. Log into Mac OS X as the user you will be running MassTransit under.   
2. If MassTransit is currently running, quit the application.   
3. Locate your backup of the MassTransit application folder; see the “Making a Backup Before 

Upgrading” section. 
4. Install MassTransit Client 5.1 included on the MassTransit 5.1 CD.  You must use an 

administrative account when installing the MassTransit Client.  
5. Copy your MTClient.CFG file and place it in your MassTransit 5.1 folder.   
6. Any customizations you have made outside the MTClient.CFG, like your communication 

methods, will need to be manually reconfigured. 
7. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 
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Migrating Configurations 
 
The following sections detail how to ensure that all configurations are properly migrated from your old 
MassTransit installation to your new one.  If you installed MassTransit to the default location, the new 
installation folder will be:  /Applications/MassTransit Server 5 Folder 
 

Preserving MassTransit.cfg Settings For Enterprise, Professional, and Satellite Servers 

 
If you were using the MassTransit.cfg file to specify settings for your previous MassTransit 
installation, you will need to make equivalent changes in the updated version of the MassTransit.cfg 
file.   
 
DO NOT simply drop your old MassTransit.cfg file in the new MassTransit directory.  Some changes 
may have been made to the settings in this file and using the newest version ensures proper operation.  
 

1. Copy the new version of the MassTransit.cfg file from the Extras folder of the new 
MassTransit installation to the main MassTransit folder.   

2. Open the new MassTransit.cfg file that you just moved in a text editor. 
3. Open the MassTransit.cfg file that you backed up from your old installation in a text editor.   
4. For each enabled setting in your old MassTransit.cfg file, uncomment the same setting and 

set the value appropriately in the new MassTransit.cfg file.   Settings with a ‘%’ preceding 
them are not enabled.   

5. Save the new MassTransit.cfg file.   
 

 

Preserving MassTransitEngine.cfg Settings For Enterprise and Professional Servers 

 
If you were using the MassTransitEngine.cfg file to specify settings for your previous MassTransit 
installation, you will need to make equivalent changes in the updated version of the 
MassTransitEngine.cfg file.   
 
DO NOT simply drop your old MassTransitEngine.cfg file in the new MassTransit directory.  Some 
changes may have been made to the settings in this file and using the newest version ensures proper 
operation.  
 

1. The new version of the MassTransitEngine.cfg file is installed by default in the main 
MassTransit folder.   

2. Open the new MassTransitEngine.cfg file in a text editor. 
3. Open the MassTransitEngine.cfg file that you backed up from your old installation in a text 

editor.   
 Note:  If you opted to backup the MassTransitEngine.cfg during the installation, the file 

exists in your main MassTransit folder and is named: MassTransitEngine.cfg.bak. 
4. For each enabled setting in your old MassTransitEngine.cfg file, uncomment the same 

setting and set the value appropriately in the new MassTransitEngine.cfg file.   Settings with 
a ‘%’ preceding them are not enabled.   

5. Save the new MassTransitEngine.cfg file.   

 

Web Configuration for Enterprise Servers Only 
 
If you are using the MassTransit web interface, you will need to update your web configuration settings.  
Please follow the instructions in the “Upgrading an Existing MTWeb 5.0.x Installation to MTWeb 5.1” 
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section of the Web Configuration Instructions document located on the MassTransit Latest Releases web 
page in the MassTransit 5.1 Documentation section:  
http://www.grouplogic.com/files/glidownload/mtreleases.cfm . 

 

Other MassTransit 5.1 Resources 
 
MassTransit 5.1 supports MySQL 5.0.  MySQL 5.0 offers improved stability and performance and will be 
required for MassTransit versions 5.2 and later.  If you would like to upgrade your MySQL database to 
5.0.42, follow the instructions in the Knowledge Base article located at: 
http://www.grouplogic.com/knowledge/index.cfm/fuseaction/view_Info/docID/284 .  This article 
provides instructions on backing up your existing MySQL database.   
 
Note: If you do not wish to use MySQL 5, MassTransit 5.1 is still compatible with MySQL 4.1.21.  To back 
up your MySQL4 database, follow the instructions in the Knowledge Base article located at: 
http://www.grouplogic.com/knowledge/index.cfm/fuseaction/view/docID/243 . 
 
For additional information on how to set up, configure, and use MassTransit 5.1 and its new features, go 
to http://www.grouplogic.com/files/mt/51/OtherMassTransit51Resources.html.  The Group Logic 
Knowledge Base contains many articles that provide detailed information on MassTransit 5.1 and its 
features and components.  The HTML version of this file, “OtherMassTransit51Resources.html”, is 
provided with your MassTransit 5.1 CD. 
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Upgrading on Windows 

 

MassTransit Versions Prior to 4.5 
 
Prior to upgrading to MassTransit 5.1, you will need to upgrade your current version of MassTransit to 
MassTransit 4.5.  To download MassTransit 4.5, go to the MassTransit 4.5 Releases section located at: 
http://www.grouplogic.com/files/glidownload/mtreleases.cfm .  This Web site also includes upgrading 
instructions in the MassTransit 4.5 Documentation section.  Once you have successfully upgraded to 
MassTransit 4.5, you can then upgrade to 5.1; follow the instructions below.  If you need assistance 
upgrading, please contact Group Logic Support at support@grouplogic.com or call 703-527-7979. 
 

MassTransit 4.5 to 5.1 
 
To install MassTransit 5.1 on Windows 2000 [SP4] Server or Professional, Windows 2003, or Windows XP 
Professional, you will need to have a USB or parallel port hardware key and a version 5 serial number.  
Please contact Group Logic Technical Support if you need to obtain these.  Email 
support@grouplogic.com or call 703-527-7979. 
 

Enterprise and Professional Servers 
 

1. Be sure that you have sent all queued files.   
2. If MassTransit is currently running stop the service.   
3. Back up your MassTransit application folder; see the “Making A Backup Before Upgrading” 

section.   
4. Verify MySQL is installed and running as a service; see the Installation Guide for Windows 

included on the CD for assistance.  Follow the “Installing MySQL” section.  
5. Install MassTransit 5.1; see the Installation Guide for Windows included on the CD for assistance.  

Follow the “Installing MassTransit” section.  
 

Running the Database (DB) Converter 

 
The DB Converter is a tool installed with MassTransit to convert your databases.  It will convert all 
contacts and their associated data, as well as all configuration settings, including listens, actions, services, 
and priorities.  Files and log tables will not be converted.  The tool consists of two components: the 4.5 
exporter, “MT 4.5 DB Export.exe” and the 5.1 importer, “Import 4.5 Data.vbs”.  The former exports your 
4.5 databases; the latter imports the converted databases to 5.1.  If you’re installing MassTransit on a 
different server, skip to the next section, “Running the DB Converter when 4.5 and 5.1 are on Different 
Servers”. 
 

6. Double-click the MT 4.5 DB Export.exe located in the following default path: C:\Program 
Files\Group Logic\MassTransit Server 5\DB Converter\45Export. 

a. An introductory window appears; select the Next button to continue. 
b. An explanation window appears explaining the conversion that is about to occur.  Once 

you have read the explanation, select Next to continue. 
c. The next window requires the locations of your MassTransit 4.5 and MassTransit 5.1 

application folders. 
i. To locate your 4.5 application folder, select Browse… and the “Browse for 

Folder” dialog opens. The default installation path is C:\Program 
Files\MassTransit.  Locate the folder and select OK to close the dialog. 
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ii. To locate your 5.1 application folder, select Browse… and the “Browse for 
Folder” dialog opens. The default installation path is C:\Program Files\Group 
Logic\MassTransit Server 5.  Locate the folder and select OK to close the dialog. 

iii. Select the Finish button to complete the conversion. 
d. When the conversion is complete, the DB Converter Log.txt populates to the DB 

Converter folder.  This log lists everything converted. 
7. Double-click the Import 4.5 Data.vbs script located in the following default path: C:\Program 

Files\Group Logic\MassTransit Server 5\DB Converter\51Import. 
a. A “Browse For Folder” dialog appears.  Select the MassTransit 5 folder; the default path 

is C:\Program Files\Group Logic\MassTransit Server 5.  Select OK to continue. 
b. A series of dialogs appear asking for MySQL information: 

i. Enter your MySQL server address: Enter localhost (default).  Select OK to 
continue. 

ii. Enter your MySQL server user name: Use either root (default) or the username 
you created when you installed MassTransit, i.e. “masstransit”.  We recommend 
using your username; it is more restrictive and safer to use.  Select OK to 
continue. 

iii. Enter your MySQL server password and select OK to continue. 
c. When the import completes, a terminal window appears for just a moment and the DB 

Importer Log.txt populates to the DB Converter folder.  This log lists everything 
imported. 

8. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 
 

Running the DB Converter when 4.5 and 5.1 are on Different Machines 

 
If you’re installing MassTransit on a different machine, follow these instructions to convert your 
databases.  Note: The DB Converter only converts Mac -> Mac or Win -> Win; the DB Converter does not 
support cross-platform conversions.   
 
When you run the MT 4.5 DB Export.exe on your MassTransit 4.5 server, a file called MassTransit 
Data.xml is generated when the conversion completes.  You will have to manually move the MassTransit 
Data.xml file to your MassTransit 5.1 server, run the importer, Import 4.5 Data.vbs, and your database 
conversion will be complete. 
 

1. Follow steps 1-5 as listed above. 
2. Put MT 4.5 DB Export.exe anywhere on the MassTransit 4.5 server.  MT 4.5 DB Export.exe is 

installed by MassTransit and is located in the following default path: C:\Program Files\Group 
Logic\MassTransit Server 5\DB Converter\45Export.  It is also included on the CD.   

3. Double-click the MT 4.5 DB Export.exe. 
a. An introductory window appears; select the Next button to continue. 
b. An explanation window appears explaining the conversion that is about to occur.  Once 

you have read the explanation, select Next to continue. 
c. The next window requests the location of two folders: the MassTransit 4.5 application 

folder and the MassTransit 5.1 application folder.  Instead of using the MassTransit 5.1 
application folder, you can use any folder.  When MT 4.5 DB Export.exe runs, the 
MassTransit Data.xml file is generated and placed in that folder.  This is the file you will 
manually move to the MassTransit 5.1 server. 

i. To locate your 4.5 application folder, select Browse… and the “Browse for 
Folder” dialog opens. The default installation path is C:\Program 
Files\MassTransit.  Locate the folder and select OK to close the dialog. 

ii. Instead of your 5.1 application folder, select Browse… and select the folder of 
your choice.  Select OK to close the dialog. 
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iii. Select the Finish button to complete the conversion. 
4. When the conversion is complete, go to the folder you selected as your MassTransit 5.1 

application folder in step 3.c.ii and locate the MassTransit Data.xml file. 
5. Place the MassTransit Data.xml file in the root MassTransit 5.1 folder.  The default path is: 

C:\Program Files\Group Logic\MassTransit Server 5\. 
6. From the MassTransit 5.1 server, double-click the Import 4.5 Data.vbs script located in the 

following default path: C:\Program Files\Group Logic\MassTransit Server 5\DB 
Converter\51Import. 

a. A “Browse For Folder” dialog appears.  Select the MassTransit 5 folder; the default path 
is C:\Program Files\Group Logic\MassTransit Server 5.  Select OK to continue. 

b. A series of dialogs appear asking for MySQL information: 
i. Enter your MySQL server address: Enter localhost (default).  Select OK to 

continue. 
ii. Enter your MySQL server user name: Use either root (default) or the username 

you created when you installed MassTransit, i.e. “masstransit”.  We recommend 
using your username; it is more restrictive and safer to use.  Select OK to 
continue. 

iii. Enter your MySQL server password and select OK to continue. 
c. When the import completes, a terminal window appears for just a moment and the DB 

Importer Log.txt populates to the 51Import folder.  This log lists everything imported. 
7. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 

 

Satellite Servers 
 

1. Be sure that you have sent all queued files.   
2. If MassTransit is currently running, quit the application or stop the service.   
3. Back up your MassTransit application folder; see the “Making A Backup Before Upgrading” 

section.   
4. Install InstallMT5Satellite.exe included on the MassTransit 5.1 CD.  You must use an 

administrative account when installing the MassTransit Satellite server.  
5. Copy your MTClient.CFG file and place it in your MassTransit 5.1 folder. 
 

Running the DB Converter 

 
The DB Converter is a tool installed with MassTransit to convert your databases.  It will convert all 
contacts and their associated data, as well as all configuration settings, including listens, actions, services, 
and priorities.  Files and log tables will not be converted.  The tool consists of two components: the 4.5 
exporter, “MT 4.5 DB Export.exe” and the 5.1 importer, “Import 4.5 Data Embedded.vbs”.  The former 
exports your 4.5 databases; the latter imports the converted databases to 5.1.  If you’re installing 
MassTransit on a different server, skip to the next section, “Running the DB Converter when 4.5 and 5.1 
Satellites are on Different Servers”. 
 

6. Double-click the MT 4.5 DB Export.exe located in the following default path: C:\Program 
Files\Group Logic\MassTransit Satellite 5\DB Converter\45Export. 

a. An introductory window appears; select the Next button to continue. 
b. An explanation window appears explaining the conversion that is about to occur.  Once 

you have read the explanation, select Next to continue. 
c. The next window requires the locations of your MassTransit 4.5 and MassTransit 5.1 

application folders. 
i. To locate your 4.5 application folder, select Browse… and the “Browse for 

Folder” dialog opens. The default installation path is C:\Program 
Files\MassTransit.  Locate the folder and select OK to close the dialog. 
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ii. To locate your 5.1 application folder, select Browse… and the “Browse for 
Folder” dialog opens. The default installation path is C:\Program Files\Group 
Logic\MassTransit Satellite 5.  Locate the folder and select OK to close the 
dialog. 

iii. Select the Finish button to complete the conversion. 
d. When the conversion is complete, the DB Converter Log.txt populates to the DB 

Converter folder.  This log lists everything converted. 
7. Double-click the Import 4.5 Data Embedded.vbs script located in the following default path: 

C:\Program Files\Group Logic\MassTransit Satellite 5\DB Converter\51Import. 
a. A “Browse For Folder” dialog appears.  Select the MassTransit 5 folder; the default path 

is C:\Program Files\Group Logic\MassTransit Satellite 5.  Select OK to continue. 
b. When the import completes, a terminal window appears for just a moment and the DB 

Importer Log.txt populates to the DB Converter folder.  This log lists everything 
imported. 

8. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 
 

Running the DB Converter when 4.5 and 5.1 Satellites are on Different Machines 

 
If you’re installing your MassTransit 5.1 Satellite Server on a different machine, follow these instructions 
to convert your databases.  Note: The DB Converter only converts Mac -> Mac or Win -> Win; the DB 
Converter does not support cross-platform conversions.   
 
When you run MT 4.5 DB Export.exe on your MassTransit 4.5 Satellite server, a file called MassTransit 
Data.xml is generated when the conversion completes.  You will have to manually move the MassTransit 
Data.xml file to your MassTransit 5.1 Satellite server, run the importer, Import 4.5 Data Embedded.vbs, 
and your database conversion will be complete. 
 

1. Follow steps 1-5 as listed above. 
2. Put MT 4.5 DB Export.exe anywhere on the MassTransit 4.5 Satellite server.  MT 4.5 DB 

Export.exe is installed by MassTransit and is located in the following default path: C:\Program 
Files\Group Logic\MassTransit Satellite 5\DB Converter\45Export.  It is also included on the 
CD.   

3. Double-click the MT 4.5 DB Export.exe. 
a. An introductory window appears; select the Next button to continue. 
b. An explanation window appears explaining the conversion that is about to occur.  Once 

you have read the explanation, select Next to continue. 
c. The next window requests the location of two folders: the MassTransit 4.5 application 

folder and the MassTransit 5.1 application folder.  Instead of using the MassTransit 5.1 
application folder, you can use any folder.  When MT 4.5 DB Export.exe runs, the 
MassTransit Data.xml file is generated and placed in that folder.  This is the file you will 
manually move to the MassTransit 5.1 Satellite server. 

i. To locate your 4.5 application folder, select Browse… and the “Browse for 
Folder” dialog opens. The default installation path is C:\Program 
Files\MassTransit.  Locate the folder and select OK to close the dialog. 

ii. Instead of your 5.1 application folder, select Browse… and select the folder of 
your choice.  Select OK to close the dialog. 

iii. Select the Finish button to complete the conversion. 
4. When the conversion is complete, go to the folder you selected as your MassTransit 5.1 

application folder in step 3.c.ii and locate the MassTransit Data.xml file. 
5. Place the MassTransit Data.xml file in the root MassTransit 5.1 Satellite folder.  The default path 

is: C:\Program Files\Group Logic\MassTransit Satellite 5\. 
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6. From the MassTransit 5.1 Satellite server, double-click the Import 4.5 Data Embedded.vbs script 
located in the following default path: C:\Program Files\Group Logic\MassTransit Satellite 5\DB 
Converter\51Import. 

a. A “Browse For Folder” dialog appears.  Select the MassTransit 5 folder; the default path 
is C:\Program Files\Group Logic\MassTransit Satellite 5.  Select OK to continue. 

b. A series of dialogs appear asking for MySQL information: 
c. When the import completes, a terminal window appears for just a moment and the DB 

Importer Log.txt populates to the 51Import folder.  This log lists everything imported. 
7. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 

 

Application Clients 
 
The DB Converter does not upgrade Clients. Follow the below instructions to manually upgrade your 
Client. 

1. Be sure that you have sent all queued files.   
2. If MassTransit is currently running, quit the application.   
3. Locate your backup of the MassTransit application folder; see the “Making a Backup Before 

Upgrading” section. 
4. Install InstallMT5Client.exe included on the MassTransit 5.1 CD.  You must use an administrative 

account when installing the MassTransit Client. 
5. Copy your MTClient.CFG file and place it in your MassTransit Client 5 folder. 
6. Any customizations you have made outside the MTClient.CFG, like your communication 

methods, will need to be manually reconfigured. 
7. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 

 

Migrating Configurations  
 
The following sections detail how to ensure that all configurations are properly migrated from your old 
MassTransit installation to your new one.  If you installed MassTransit to the default location, the new 
installation folder will be:  C:\Program Files\Group Logic\MassTransit Server 5 
 
 

Copying User Mailboxes  

 
Copy your User Mailboxes folder from the backup of your old MassTransit Folder to the new MassTransit 
Folder.  If you choose not to do this, MassTransit will create a new User Mailboxes folder when it starts 
up. 
 
If you are running on Mac OS X and share the user mailboxes, copy the contents of the old “User 
Mailboxes” folder from your previous installation to the “User Mailboxes” folder in the new MassTransit 
folder.  If you want to make the mailboxes available to all users, run the “Set User Mailbox Permissions” 
script, available on the Group Logic website: 
http://www.grouplogic.com/files/mt/scripts/mac/SetUserMailboxPermissions.hqx 
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Maintaining Verified Certificates 

  
If you are using a verified certificate [e.g. one purchased from VeriSign], you may need to ensure that the 
certificate and private key files are configured properly for the new version of MassTransit.   
 
If the certificate and/or private key files were located in the “Security” folder of your previous 
MassTransit installation you will need to move them to the “Security” folder of the new MassTransit 
installation.  In addition, when you restart MassTransit, go to Setup->Security to update the preferences 
to access the files at their new location.  If you’re using verified SSL certificates, the mtcert.pem (located in 
the Security folder) and mtkey.pem (located in the private folder) files must be manually moved from the 
backed up Security folder into the 5.1 Security folder.   
 
On Windows, if the certificate and/or private key files were not located within the previous MassTransit 
installation folder then no action is needed as MassTransit will continue to find the files in their present 
location if you are installing on the same server.  If you are not installing MassTransit 5.1 on the same 
server, then you will need to copy the certificate and/or private key files to the new server. 
 
On Macintosh, no matter where you install MassTransit 5.1, you will need to convert all SSL certificate 
and key files with Macintosh line endings to Unix line endings.  There is a script called, “Convert 
Certificates to 5.app” that does this in your Extras folder.  The default location is: 
/Applications/MassTransit Server 5 Folder/Extras.   
 

To run the script: 
1. Double-click “Convert Certificates to 5.app”. 
2. A dialog appears with buttons asking you to Convert one file or to Convert a folder hierarchy.  

If you wish to convert just one certificate or key file, select the Convert one file button.  If you 
wish to convert all of your certificate and key files at once and they are in a single folder, select 
the Convert a folder hierarchy button.   

3. The “Choose a File” or “Choose a Folder” dialog appears based on your selection.  Choose the 
certificate, key file, or folder hierarchy you want to convert.  Select the Choose button to continue.  

4. A dialog appears informing you that the script has completed successfully.  It also tells you to go 
to your desktop and locate the folder named, “MassTransit 5 Cert”.  The converted files or folder 
hierarchy are in that folder.  Select OK to close the dialog. 

5. Copy the converted files and place them in the appropriate folder.  If they were in your Security 
folder, put the converted files in the MassTransit 5.1 Security folder, or if they were not in your 
previous MassTransit installation, replace them in that same location.  You can overwrite the 
original files, as they should be saved with your backup. 

 

Preserving MassTransit.cfg Settings For Enterprise and Professional Servers 

 
If you were using the MassTransit.cfg file to specify settings for your previous MassTransit 
installation, you will need to make equivalent changes in the updated version of the MassTransit.cfg 
file.   
 
DO NOT simply drop your old MassTransit.cfg file in the new MassTransit directory.  Some changes 
may have been made to the settings in this file and using the newest version ensures proper operation.   
 

1. Copy the new version of the MassTransit.cfg file from the Extras folder of the new 
MassTransit installation to the main MassTransit folder.   

2. Open the new MassTransit.cfg file that you just moved in a text editor. 
3. Open the MassTransit.cfg file that you backed up from your old installation in a text editor.   
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4. For each enabled setting in your old MassTransit.cfg file, uncomment the same setting and 
set the value appropriately in the new MassTransit.cfg file.   Settings with a ‘%’ preceding 
them are not enabled.   

5. Save the new MassTransit.cfg file.   
 

Maintaining MT IP Addresses.txt 

 
If you were using MT IP Addresses.txt on your previous MassTransit installation, copy the MT IP 
Addresses.txt file that you backed up into the new MassTransit folder.  No changes to the actual file 
are required. 
 

Consider Updating Aliases and Shortcuts 

 
If you have an alias or shortcut that you used to launch the previous version of MassTransit, you may 
want to update it to point to the new version. This is especially important if you have one as a startup 
item, to ensure that the old version of MassTransit is not launched automatically. 
 
 

Web Configuration for Enterprise Servers Only 
 
Starting with MassTransit 5.0 there is a new Web site for web client configuration.  For information about 
configuring MassTransit for use with web servers, see the Web Configuration Instructions document 
located on the MassTransit Latest Releases web page in the MassTransit 5.1 Documentation section:  
http://www.grouplogic.com/files/glidownload/mtreleases.cfm . 
 
 

Other MassTransit 5.1 Resources 
Go to http://www.grouplogic.com/files/mt/51/OtherMassTransit51Resources.html for additional 
articles to help you set up, configure, and use MassTransit 5.1 and its new features.  The Group Logic 
Knowledge Base contains many articles that provide detailed information on MassTransit 5.1 and its 
features and components.  The HTML version of this file, “OtherMassTransit51Resources.html”, is 
provided with your MassTransit 5.1 CD or with your download package. 
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MassTransit 5.0 to 5.1 
 
When upgrading your Enterprise, Professional, Client, or Satellite server to MassTransit 5.1 from 
MassTransit 5.0, it is not necessary to run the DB Converter application.   
 

Enterprise and Professional Servers 
 

1. If MassTransit is currently running, stop the service.   
2. Back up your MassTransit application folder; see the “Making A Backup Before Upgrading” 

section.   
3. Verify MySQL is running. 
4. Run InstallMT5Server.exe to install MassTransit 5.1.   

Note: During the installation process, the Enterprise installer will give you the option of backing 
up the MassTransitEngine.cfg file and the entire MTWeb folder.  Select OK to ensure your 
configurations are backed up.   

5. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 
 

Satellite Servers 
 

1. If MassTransit is currently running, quit the application or stop the service.   
2. Back up your MassTransit application folder; see the “Making A Backup Before Upgrading” 

section.   
3. Install InstallMT5Satellite.exe included on the MassTransit 5.1 CD.  You must use an 

administrative account when installing the MassTransit Satellite server.  
4. Copy your MTClient.CFG file and place it in your MassTransit 5.1 folder. 
5. Copy the data folder from your backed up Satellite Databases folder into your 5.1 Databases 

folder.   
6. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 

 

Application Clients 
 

1. If MassTransit is currently running, quit the application.   
2. Backup your MassTransit application folder; see the “Making a Backup Before Upgrading” 

section. 
3. Install InstallMT5Client.exe included on the MassTransit 5.1 CD.  You must use an administrative 

account when installing the MassTransit Client. 
4. Copy your MTClient.CFG file and place it in your MassTransit Client 5 folder. 
5. Any customizations you have made outside the MTClient.CFG, like your communication 

methods, will need to be manually reconfigured. 
6. Follow the rest of the upgrading instructions in the “Migrating Configurations” section. 
 

Migrating Configurations 
 
The following sections detail how to ensure that all configurations are properly migrated from your old 
MassTransit installation to your new one.  If you installed MassTransit to the default location, the new 
installation folder will be:  C:\Program Files\Group Logic\MassTransit Server 5 
 

Preserving MassTransit.cfg Settings For Enterprise and Professional Servers 
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If you were using the MassTransit.cfg file to specify settings for your previous MassTransit 
installation, you will need to make equivalent changes in the updated version of the MassTransit.cfg 
file.   
 
DO NOT simply drop your old MassTransit.cfg file in the new MassTransit directory.  Some changes 
may have been made to the settings in this file and using the newest version ensures proper operation.  
 

1. Copy the new version of the MassTransit.cfg file from the Extras folder of the new 
MassTransit installation to the main MassTransit folder.   

2. Open the new MassTransit.cfg file that you just moved in a text editor. 
3. Open the MassTransit.cfg file that you backed up from your old installation in a text editor.   
4. For each enabled setting in your old MassTransit.cfg file, uncomment the same setting and 

set the value appropriately in the new MassTransit.cfg file.   Settings with a ‘%’ preceding 
them are not enabled.   

5. Save the new MassTransit.cfg file.   
 

 

Preserving MassTransitEngine.cfg Settings For Enterprise and Professional Servers 

 
If you were using the MassTransitEngine.cfg file to specify settings for your previous MassTransit 
installation, you will need to make equivalent changes in the updated version of the 
MassTransitEngine.cfg file.   
 
DO NOT simply drop your old MassTransitEngine.cfg file in the new MassTransit directory.  Some 
changes may have been made to the settings in this file and using the newest version ensures proper 
operation.  
 

1. The new version of the MassTransitEngine.cfg file is installed by default in the main 
MassTransit folder.   

2. Open the new MassTransitEngine.cfg file in a text editor. 
3. Open the MassTransitEngine.cfg file that you backed up from your old installation in a text 

editor.   
 Note:  The MassTransitEngine.cfg was backed up during the installation; the file exists in 

your main MassTransit folder and is named: 
MassTransitEngine.cfg.[datestamp].[timestamp].bak. 

4. For each enabled setting in your old MassTransitEngine.cfg file, uncomment the same 
setting and set the value appropriately in the new MassTransitEngine.cfg file.   Settings with 
a ‘%’ preceding them are not enabled.   

5. Save the new MassTransitEngine.cfg file.   
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Web Configuration for Enterprise Servers Only 

 
If you are using the MassTransit web interface, you will need to update your web configuration settings.  
Please follow the instructions in the “Upgrading an Existing MTWeb 5.0.x Installation to MTWeb 5.1” 
section of the Web Configuration Instructions document located on the MassTransit Latest Releases web 
page in the MassTransit 5.1 Documentation section:  
http://www.grouplogic.com/files/glidownload/mtreleases.cfm . 

 

Other MassTransit 5.1 Resources 
 
MassTransit 5.1 supports MySQL 5.0.  MySQL 5.0 offers improved stability and performance and will be 
required for MassTransit versions 5.2 and later.  If you would like to upgrade your MySQL database to 
5.0.42, follow the instructions in the Knowledge Base article located at: 
http://www.grouplogic.com/knowledge/index.cfm/fuseaction/view_Info/docID/284 .  This article 
provides instructions on backing up your existing MySQL database.   
 
Note: If you do not wish to use MySQL 5, MassTransit 5.1 is still compatible with MySQL 4.1.21.  To back 
up your MySQL4 database, follow the instructions in the Knowledge Base article located at: 
http://www.grouplogic.com/knowledge/index.cfm/fuseaction/view/docID/243 . 
 
Go to http://www.grouplogic.com/files/mt/51/OtherMassTransit51Resources.html for additional 
articles to help you set up, configure, and use MassTransit 5.1 and its new features.  The Group Logic 
Knowledge Base contains many articles that provide detailed information on MassTransit 5.1 and its 
features and components.  The HTML version of this file, “OtherMassTransit51Resources.html”, is 
provided with your MassTransit 5.1 CD or with your download package. 
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Verifying the Upgrade 
 
Once you have completed all the upgrade steps, you can launch MassTransit.   
 

Mac OS X 
 

Launching the MassTransit Engine 

 
Double click the MassTransit Engine application located in the root MassTransit folder; the default 
location is /Applications/MassTransit Server 5 Folder/.  The MassTransit Engine icon appears on the 
dock and remains there while running.  You may want to make an alias of this program on the desktop or 
dock.   

 

Launching the MassTransit Administrator 

 
1. Double click the MassTransit Administrator application located in the root MassTransit folder; 

the default location is /Applications/MassTransit Server 5 Folder/.  The splash screen appears 
for a moment and then the MassTransit Administrator icon appears on the dock and remains 
there while running.   

2. To connect to your MassTransit server, go to the File Menu and select Connect to Server; the 
“MassTransit Servers” window appears. 

 
3. Add the server you wish to connect to: 

a. Select the Edit Server List… button; the “MassTransit Server List” appears.  
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b. Select the Add button; the “Configure MassTransit Server Connection” dialog appears.   

 
c. Add the name and address of the server you are connecting to; all fields are required.  If 

Remote Administration is enabled and you are connecting to a remote server, enter that 
machine’s information. 

i. Enter the server Name (or localhost if you are connecting locally); this is just a 
name to identify the server you’re connecting to. 

ii. Enter the server IP Address or DNS name (or localhost if you are connecting 
locally). 

iii. Enter the Port.  Use 20002 (the default) unless the MassTransit server has been 
configured to use a different port.  

d. Select OK to continue. 
4. After selecting OK you return to the “MassTransit Server List” window and see the server you 

just created. 
5. To connect, highlight the server entry and select Connect.  Note: You will be able to connect to 

the server only when the Engine is running, otherwise a dialog will appear stating that a 
connection cannot be made to the server. 

6. On connection, the “MassTransit” toolbar appears with the following buttons: Contacts, Status, 
Files, Log, and Setup.  Click any button to go to the corresponding window. 

 

Shutting Down the MassTransit Administrator 

 
To disconnect from the server only, go to the File menu and select Disconnect From Server.  This will not 
shut down the Administrator.  To exit the MassTransit Administrator go the MassTransit Administrator 
menu and select Quit MassTransit Administrator.  If you are currently connected to a server, you will be 
disconnected before the Administrator quits.   
 

Shutting Down the MassTransit Engine 

 
To shut down the MassTransit Engine, select the MassTransit Engine from the dock, go the MassTransit 
Engine menu and select Quit MassTransit Engine. 
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Windows 
 

Launching the MassTransit Engine 

 
1. The MassTransit Engine must be started via the Services Control Panel.  To access the Services 

Control Panel, go to Start -> Programs -> Administrative Tools -> Services. 
2. Once the Services window is open, highlight the service named “MassTransit” and select the 

Start Service button.  Note: This will not conflict with the 4.5 Service named, “MassTransit 
Service”, but the two cannot run simultaneously. 

3. The default startup type for the MassTransit service is Automatic, thus anytime your machine 
reboots, the MassTransit service automatically starts.  Note: MassTransit is dependent upon 
MySQL and will fail if MySQL is not started. Make sure MySQL is set to start automatically. If 
you find that MassTransit is attempting to start before MySQL is ready, you can modify the 
options in the Recovery tab of the MassTransit service to have it retry.  

4. If you would like the MassTransit Engine service to access network volumes, do the following: 
a. Go to the Services window via Start -> Programs -> Administrative Tools -> 

Services.  Highlight the MassTransit service, right click, and select Properties to open the 
"Properties" window. 

b. Go to the Log On tab and select the This account: option. 
i. Select the Browse button to browse for your valid domain user that has access to 

the volumes needed. 
ii. Enter and confirm your password. 
iii. Select OK to finish and close the "Properties" window. 

 

Launching the MassTransit Administrator 

 
1. Double click the MassTransit Administrator.exe located in the root MassTransit folder to connect 

to your MassTransit server; the default location is C:\Program Files\Group Logic\MassTransit 
Server 5.   

2. The “MassTransit Servers” window appears. 

 
3. Add the server you wish to connect to:  

a. Select the Edit Server List… button; the “MassTransit Server List” appears.  
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b. Select the Add button; the “Configure MassTransit Server Connection” dialog appears.  

 
c. Add the name and address of the server you are connecting to; all fields are required.  If 

Remote Administration is enabled and you are connecting to a remote server, enter that 
machine’s information. 

i. Enter the server Name (or localhost if you are connecting locally); this is just a 
name to identify the server you’re connecting to. 

ii. Enter the server IP Address or DNS name (or localhost if you are connecting 
locally). 

iii. Enter the Port.  Use 20002 (the default) unless the MassTransit server has been 
configured to use a different port.  

d. Select OK to continue. 
4. After selecting OK you return to the “MassTransit Server List” window and see the server you 

just created. 
5. To connect, highlight the server entry and select Connect.  Note: You will be able to connect to 

the server only when the Engine is running, otherwise a dialog will appear stating that a 
connection cannot be made to the server. 

6. The “MassTransit” window appears with a toolbar of the following buttons: Contacts, Status, 
Files, Log, and Setup.  Click any button to go to the corresponding window. 

 

Shutting Down the MassTransit Administrator 

 
To disconnect from the server only, go to the File menu and select Disconnect From Server. To exit the 
MassTransit Administrator, go the File menu and select Exit. 
 

Shutting Down the MassTransit Engine 

 
To shut down the MassTransit Engine, open the Services Control Panel, select the MassTransit service, 
and select the Stop Service button. 
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Verifying Connectivity 
 
To ensure that MassTransit can properly connect following the upgrade, attempt outgoing calls to server 
entries and verify that you can receive incoming calls.   
 
On Macintosh, if you are running MassTransit as a non-root user and want to listen below port 1024, you 
will need to configure Xinetd.  Please see Appendix A for more details. 
  
 
 

Verifying the Web Configuration for Enterprise Servers only 
 
To ensure that your web configuration is functional, verify that you can login to the MassTransit Web site, 
upload and download files.  It is advisable to do this from both inside and outside the firewall (if 
relevant) and with all user platforms (Macintosh and Windows), as there are slight differences in 
configuration that need verification.   
 
 

Other MassTransit 5.1 Resources 
 
Go to http://www.grouplogic.com/files/mt/51/OtherMassTransit51Resources.html for additional 
articles to help you set up, configure, and use MassTransit 5.1 and its new features.  The Group Logic 
Knowledge Base contains many articles that provide detailed information on MassTransit 5.1 and its 
features and components.  The HTML version of this file, “OtherMassTransit51Resources.html”, is 
provided with your MassTransit 5.1 CD or with your download package. 
 
© 1995-2008 Group Logic Incorporated.  All Rights Reserved. 
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Appendix A: Configuring Xinetd when not running as Root 
In Mac OS X, only the root user has access to ports below 1024.  Because of this limitation, in order for 
MassTransit to listen on the standard FTP or TCP/IP Secure ports, MassTransit previously needed to be 
run with root privileges.  In order to avoid this requirement, Xinetd can be used to redirect traffic from 
one port to another.  This allows MassTransit to be configured to listen on a port above 1024, but receive 
incoming traffic on a port below 1024.  For more information, see the Knowledge Base article at: 
http://www.grouplogic.com/knowledge/index.cfm/fuseaction/view/docID/172 . 


